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Universal Design for Learning Tips 

What is Universal Design? 
Universal Design (UD) is the design of products and environments to be usable by all people, to the 

greatest extent possible, without the need for adaptation or specialized design 

(https://www.ncsu.edu/ncsu/design/cud/about_ud/about_ud.htm). Simply stated, UD is design with 

consideration and benefit to all people.  

Why UD? 
Incorporating UD principles addressed in this Tip Sheet can benefit faculty and students by: 

 Reducing the need to revise for individual accommodations, saving faculty time in the long run. 

 Increasing the chances of reaching more students, for example: 

o Students with varied learning styles, 

o Older, returning students,  

o International students from another culture, or  

o Students whose first language is not English. 

 Developing documents that are more visually and structurally consistent so students can focus 

on learning content, not sifting through content. At the same time, students with visual 

impairments can more easily access the documents. 

The Scope of this Tip Sheet 
UD can include many areas such as physical space design, technology use, student services, and much 

more. This Tip Sheet focuses on three main areas: teaching strategies, document design and Blackboard 

Learn text box format. 

Teaching Strategies 

Use a Variety of Teaching Methods 
Incorporate a variety of teaching methods including lecture, class and group discussion, show a video 

clip to introduce or reinforce content, and use visual aids. Others are more hands-on methods such as 

simulations, role play, and structured exercises. Using a variety of teaching methds can increase the 

chance of reaching more students with varied learning styles, ways of understanding, and 

communicating. 

Provide Cognitive Supports 
Cognitive supports provide organization, structure, and emphasis of important content. As experts in 

their field, faculty have that in-depth understanding. Students need some scaffolding. For example 

summarize major points, provide tools such as outlines, notes, summaries, study guides, or a skeletal 

outline that students fill in during or after lecture. The supports do not have to be created solely by 

faculty. Students can work in groups or post summaries to Blackboard after class. Faculty can provide 

feedback and those objects can become study guides for all students. 

Provide Multiple Means of Representation 
A popular way to state this is “if it’s auditory make it visual. If it’s visual make it auditory” 

(https://ualr.edu/pace/tenstepsud/). If students don’t understand something the first time, an alternate 

https://www.ncsu.edu/ncsu/design/cud/about_ud/about_ud.htm
https://ualr.edu/pace/tenstepsud/
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mode might provide the key to help students understand. Make choices on what to create; prioritize 

based on importance and complexity of content.  

One place to start might be directions for important assignments. Of course you review it in class and 

provide written instructions. Take it one step further by uploading to Blackboard the typed instructions 

as well as a short audio recording of the instructions. Below is a link and instructions to a free online 

voice recording tool: 

Online Voice Recorder Instructions: 

1. Click on the link to the Online Voice Recorder: http://online-voice-recorder.com/ 

2. Click the round, red button to record. 
3. You may be prompted to allow the voice recorder to access your microphone. Click Allow. The 

round, red button will turn green. 
4. Click the round button again to stop the recording. 
5. Click Save to save the recording. Click Save again to save recording to your computer. The 

recording will be saved as an MP3 audio file for you to upload to Blackboard. 
 

Document Design 
This section will address features in Microsoft Word, PDF, and PowerPoint that add visual consistency. 

The result is a structurally organized document that enhances a student’s ability to focus on the content, 

rather than trying to sift through and figure out the organization of the content. At the same time, these 

options provide improved access for students with visual impairments who use screen readers and other 

text-to-speech programs. 

Microsoft Word 
The instructions and images below explain seven features found in Microsoft Word: fonts, styles, 

columns, lists, headers and footers, alternate text, tables. The version shown is 2013. These features are 

available in other versions, but may follow a slightly different procedure. You can search the Internet to 

find Microsoft Word tutorials for the version you have if the images below cause confusion. 

1. Fonts: Use sans-serif fonts. Sans-serif fonts don’t have the small lines (serifs) at the ends of each 

letter. An example of a serif font is Times New Roman. Notice the small lines at the top and 

bottom of the T and other letters. Those are serifs. Recommended sans-serif fonts include Ariel, 

Helvetica, Verdana, and Calibri. Below is the top, or ribbon, of a Word document that shows 

where you can change the font. 

 

 

http://online-voice-recorder.com/
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2. Styles: Using the styles tool provides navigational clues for anyone, and particularly for 

individuals who use screen readers. Below is the ribbon of a Word document that shows where 

to find the styles tool. 

 

Styles are useful to indicate titles, headings, and to convey emphasis. To choose a heading style, 

highlight the heading you want to change, then choose the specific heading style for your 

document (see image above).  

Use heading levels in a logical order, for example heading 4 is a child of heading 3, not of 

heading 2.  Click on the arrows on the right of the styles group to choose more options. 

Do not use color and bold as the only way to convey meaning. Once a style is chosen, the font, 

size, color, bold, underline, etc. can be changed to one of your choosing. 

3. Use the columns tool instead of using tabs or the space bar. You might use columns to organize 

information into newsletter-style columns. Or, you might have a long list of items or terms that 

could be organized into columns. 

Apply columns to an entire document: 

a. Click on the Page Layout tab.  

b. Click Columns.  

c. Click the column layout desired.  

Apply columns to part of a document: 

a. Highlight the typed text. 

b. Click Page Layout, then Columns. 

c. Click the desired column layout.

 

NOTE: To add a vertical line between the columns, click Columns again, click More Columns, and 

then select the ‘Line between’ check box. You can also adjust the column width and spacing. 
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4. Lists. Use the bulleted list or numbered list tools instead of using tabs or the space bar. Below is 

the ribbon of a Word document that shows where to find the bulleted list and numbered list 

tools. 

 

There are several ways of creating a bulleted or numbered list. Two are shown below. 

Type a bulleted or numbered list 

a. Type * (asterisk) to start a bulleted list or 1. to start a numbered list, and then press 

SPACEBAR or the TAB key. 

b. Type any text that you want. 

c. Press ENTER to add the next list item. 

Word automatically inserts the next bullet or number. 

d. To finish the list, press ENTER twice, or press BACKSPACE to delete the last bullet or number 

in the list. 

 

Add bullets or numbering to a list 

a. Select the items that you want to add bullets or numbering to. 

b. On the Home tab, in the Paragraph group, click Bullets or Numbering. 

 

Click on the following link for more tutorials from Microsoft Office about making lists: 

https://support.office.com/en-US/article/Create-a-bulleted-or-numbered-list-9FF81241-58A8-

4D88-8D8C-ACAB3006A23E  

 

5. Headers and Footers. Use the header or footer for placement of page numbers. 

a. From the Insert tab click Page Number.  

b. Click a location for the page number. 

c. When done, click Close Header and Footer or double-click on the main body of the 

document. 

               

https://support.office.com/en-US/article/Create-a-bulleted-or-numbered-list-9FF81241-58A8-4D88-8D8C-ACAB3006A23E
https://support.office.com/en-US/article/Create-a-bulleted-or-numbered-list-9FF81241-58A8-4D88-8D8C-ACAB3006A23E
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6. Alternate Text. When providing alternative text (alt text), descriptive text appears when moving 

the mouse over a shape, picture or table. If you are viewing this Tip Sheet as a PDF, you can see 

alt text for each of the pictures in this document.  

 

Alt text helps people who use screen readers to understand the content of images and tables in 

a document. For many readers, this is the only information they have about the images in your 

document. Using alt text can also provide cultural or contextual information for international 

students. 

To format pictures, or shapes 

a. Right-click the item (picture or shape) and click Format Picture or Format Shape.  

 
b. Click the Layout and Properties icon (square shape shown below). The Alt Text option 

appears below that. 

 
c. In the Description box, enter an explanation of the shape or picture. This box should always 

be filled in. 

d. If you want, enter a brief summary in the Title box. This box should only be filled in if you 

are entering a detailed or long explanation in the Description box. By using the Title box, 

people won’t need to read the full description unless they want to. 
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To format tables 

a. Right-click the table and click Table Properties. 

  
b. Click the Alt Text tab. 

  
c. In the Description box, enter an explanation of the table. This box should always be filled in. 

d. If you want, enter a brief summary in the Title box. This box should only be filled in if you 

are entering a detailed or long explanation in the Description box. By using the Title box, 

people won’t need to read the full description unless they want to. 
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7. Tables. Tables provide a clear and succinct format for presenting certain types of 

information. But like images, tables can be difficult to interpret for people who cannot see 

them. To ensure that your tabular information remains understandable to all readers, do 

the following: 

a. Keep tables as simple as possible. Use two tables rather than one very complicated table 
whenever possible. 

b. Design tables so that they make sense when linearized (i.e., when read strictly from left 
to right, top to bottom). 

c. Give the table a simple, clear title. 
d. If you add a caption (or alt text) to the table, summarize the table’s significant 

information concisely but clearly. For example, “Steve’s office hours are 10-11, Tuesday 
through Thursday,” rather than “Table shows Steve’s office hours.” 

e. Make use of table headers, order them logically, and name them clearly. More about 
table headers below. 

 

What’s in a table header? 

Headers help readers understand how tables are organized into columns and rows. While 
many authors try to indicate a header row by changing its appearance (e.g., font and 
background color), a change of this type provides little or no information about 
the structure of the table. A document that relies entirely on visual formatting will, when 
converted to HTML or PDF, lack the structural information needed by readers who use 
assistive technology. 

Fortunately, Word offers a setting for table headers that provides this important structural 
information. This brief tutorial shows you how to set this table header property. 

To assign “heading” status to a table row in Microsoft Word (images below are from version 
2013), follow these steps: 

a. Click inside any cell in the first row of the table (actually, Word allows you to select 
multiple rows as headers, so long as the first row of the table is included in the 
selection). 

b. On the Ribbon, locate the Table Tools tab group (Figure 1a) and click on the Layout tab 
(Figure 1b). 

c. Make sure the “Repeat Header Rows” option is selected (Figure 1c). 
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PDF Documents 
If you save a Word document as a PDF file, the elements (styles, alt text) used in the Word document 

will be saved in the PDF document. If you scan something (ex: page from a book) and save as a PDF, a 

screen reader may not be able to read the text of the scanned document. Check if the document has 

recognized text. If you try to highlight text and cannot, the text is not recognized. Follow the steps below 

to convert it. Note: The steps shown are for Adobe Acrobat Pro DC. 

1. Open the scanned PDF. Click on Tools. 

 
 

2. Click Open under Enhance Scans. 

 
 

3. Click Recognize Text. A drop down menu will appear. Click on This File. 

 
 

 

4. Click Recognize Text. The document will covert to text that is recognized as text by a screen 

reader. This may take several minutes. Save the revised document.  

 
After the conversion, you should be able to highlight text with your cursor. 
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PowerPoint Slides 
Many of the same principles used when formatting Microsoft Word documents apply to PowerPoint 

slides: Use sans-serif fonts, use the Columns tool, use bulleted or numbered lists, and provide alt text for 

pictures and tables. Other best practices include: 

1. Keep slide format simple. 

2. Include a title for each slide. 

3. Use bullets to distinguish each point. 

4. Put a period at the end of each point. 

Blackboard Learn Text Box Format 
When designing your course in Blackboard, often you will see a text box for entering information:  

 

 

Follow these best practices: 

1. As with Word documents, use consistent headings when typing into text boxes. The default 

option is Paragraph, for non-headings. Click on the Paragraph option to see different 

heading options if you choose to use them. Use the headings and subheadings instead of 

solely relying on bolding, underlining, and font size. 

2. Indent and outdent text using the feature above, rather than tabs and spacebar. 

3. Use the bulleted or numbered listing tools rather than tabs and space bar. 

 

1

. 

2

. 

3

. 
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Resources 
Ten Simple Steps Toward Universal Design of Online Courses. 

http://ualr.edu/pace/tenstepsud/  

Universal Design in Higher Education: From Principles to Practice, Second Edition (2015). 

Cheryl E. Burgstahler, Editor. Harvard Education Press, Cambridge, MA. 

Creating Accessible Word Documents. 

https://support.office.com/en-US/Article/Creating-accessible-Word-documents-d9bf3683-87ac-47ea-

b91a-78dcacb3c66d?ui=en-US&rs=en-US&ad=US  

Colorado State University Access Project. 

http://accessproject.colostate.edu/udl/modules/word/mod_word.php?display=pg_4  

 

http://ualr.edu/pace/tenstepsud/
https://support.office.com/en-US/Article/Creating-accessible-Word-documents-d9bf3683-87ac-47ea-b91a-78dcacb3c66d?ui=en-US&rs=en-US&ad=US
https://support.office.com/en-US/Article/Creating-accessible-Word-documents-d9bf3683-87ac-47ea-b91a-78dcacb3c66d?ui=en-US&rs=en-US&ad=US
http://accessproject.colostate.edu/udl/modules/word/mod_word.php?display=pg_4

